
DRAFT: DO NOT USE FOR FILMING 
 

© 2024, Journal of Visualized Experiments  Page 1 of 12 

Submission ID #: 67849 
Scriptwriter Name: Poornima G 
Project Page Link: https://review.jove.com/account/file-uploader?src=20693993  
 

Title: Leveraging Virtual Reality for Immersive Segmentation and 
Analysis of Cryo-electron Tomography Data 

 
Landing Page Title (not for video use): 3D Cryo-ET Data Segmentation Using Advanced VR 
Interaction Tools 
 

☒   The Landing Page Title is correct. (Character limit with spaces: 80) 

 
 

Authors and Affiliations:  
Carissa Chestnut1,2,*, Jake D. Johnston2,3,*, Marcus Velazquez1,2,*, Kasahun 
Neselu2, Edward T. Eng2  
 
1Stony Brook University, Stony Brook, NY, USA 
2Simons Electron Microscopy Center, New York Structural Biology Center 
3Department of Physiology and Cellular Biophysics, Columbia University 
 
*These authors contributed equally 
 

☒   All author names and affiliations are correct (city/state/country information not included 
in video title page).  

 
 
Corresponding Authors:  

Edward T. Eng    eeng@nysbc.org 
 
 
Email Addresses for All Authors:  

Carissa Chestnut    carissa.chestnut@stonybrook.edu 
Jake D. Johnston    jdj2137@cumc.columbia.edu 
Marcus Velazquez           marcus.velazquez@stonybrook.edu 
Kasahun Neselu    kneselu@nysbc.org 
Edward T. Eng    eeng@nysbc.org 

 
 
  

https://review.jove.com/account/file-uploader?src=20693993


DRAFT: DO NOT USE FOR FILMING 
 

© 2024, Journal of Visualized Experiments  Page 2 of 12 

Author Questionnaire 

1. Microscopy: Does your protocol require the use of a dissecting or stereomicroscope for 
performing a complex dissection, microinjection technique, or something similar?  Enter Yes 
or No.  No 

If Yes, can you record movies/images using your own microscope camera? 

Enter Yes or No.   

If your protocol involves microscopy but you are not able to record movies/images with 
your microscope camera, JoVE will need to use our scope kit.  

If your microscope does not have a camera port, the scope kit will be attached to one of 
the eyepieces and you will have to perform the procedure using one eye. 

Enter make and model of microscope. 

Data was collected on Titan Krios. 

If a dissection or stereo microscope is required for your protocol, please list all shots 
from the script that will be visualized using the microscope (shots are indicated with the 
3-digit numbers, like 2.1.1, 2.1.2, etc.). 

Click here to list microscope shots, using the shot numbers from the protocol section 
of the video script. 

No Microscope shots needed. 

2. Software: Does the part of your protocol being filmed include step-by-step descriptions of 
software usage?  Enter Yes or No. 

Yes 

If Yes, we will need you to record using screen recording software. 

We recommend using the screen capture program OBS. JoVE’s tutorial for using OBS 
Studio is provided at this link: https://review.jove.com/v/5848/screen-capture-
instructions-for-authors?status=a7854k 

As these files are necessary for finalizing your script, please upload all screen-captured 
video files to your project page as soon as possible. 

We will use OBS to screen capture and upload to our project page. 

 

3. Filming location: Will the filming need to take place in multiple locations?   Enter Yes or No. 

No, Filming location will be at New York Structural Biology Center. 

If Yes, how far apart are the locations? Click to enter distance between locations. 
 

https://obsproject.com/
https://review.jove.com/v/5848/screen-capture-instructions-for-authors?status=a7854k
https://review.jove.com/v/5848/screen-capture-instructions-for-authors?status=a7854k


DRAFT: DO NOT USE FOR FILMING 
 

© 2024, Journal of Visualized Experiments  Page 3 of 12 

To ensure that your script can be filmed in one day, the protocol sections are cumulatively 
restricted to 55 shots (shots are the 3-digit numbers like 2.1.1, 2.1.2…etc) 
 
Current Protocol Length 
Number of Steps:  24 
Number of Shots:  40 (35 SC)   
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Interviews  
1. Video 1: Author Spotlight: Title (Filled by scriptwriter during script finalization) 
 

 
 
Videographer: Obtain headshots for all authors available at the filming location.  
 

Answers to these questions will become interview statements that you will deliver on camera. 

• Answer the 1st REQUIRED question and at least 2 other questions (1.2 – 1.10) below. Up 
to 5 interview statements will be included in the video. 

• Enter the full name of the author who will deliver the statement. 

• If possible, each author should deliver no more than two statements. 

• Answer in full sentences, in a style suitable for being spoken aloud.  

• Limit the length of each statement to 50 words or fewer. 

• Answers will be edited for length, clarity, and consistency with journal style guidelines. 

 
REQUIRED: What is the scope of your research? What questions are you trying to answer?  

1.1. Carissa Chestnut: In this work, we describe a protocol that uses the software SyGlass 
to segment cryo-electron tomography data. SyGlass is a virtual reality-based software 
that provides an immersive and intuitive interface for segmenting cryo-ET tomograms. 
We demonstrate that VR is a viable tool that can be integrated into cryo-ET 
segmentation pipelines. 

 
What are the most recent developments in your field of research? 

1.2. Marcus Velazquez: Cryo-ET is advancing rapidly, with innovations in focused-ion beam 
milling for thinning cells, faster data collection methods, and machine learning 
improving automated particle picking and segmentation. These advancements are 
accelerating the adoption of cryo-ET as a powerful tool for gaining biological insights. 
 

What technologies are currently used to advance research in your field? 

1.3. Carissa Chestnut: Technologies like cryo-focused ion beam milling, direct electron 
detectors on 300 kev TEMs, and additionally, automated software tools for tomogram 
reconstruction, segmentation, and machine learning for particle picking are essential 
for processing and interpreting the large datasets that can be generated in cryo-ET.  
 

What are the current experimental challenges? 
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1.4. Marcus Velazquez: Cryo-ET faces challenges like low-throughput cryo-FIB milling for 
samples thicker than 500 nm and difficulty targeting regions of interest due to low 
copy numbers. Additionally, data processing remains a bottleneck, requiring extensive 
manual annotation for particle picking and segmentation along with specialized 
expertise, which slows down the overall workflow. 

 
What significant findings have you established in your field? 

1.5. Carissa Chestnut: We found that virtual reality improves segmentation efficiency 
compared to traditional methods. Its immersive environment complements 
automated approaches by filling gaps and reducing false positives. Additionally, this 
VR platform is highly effective for training and education, making it a versatile tool in 
cryo-ET data analysis. 
 

What research gap are you addressing with your protocol? 

1.6. Marcus Velazquez: Our protocol addresses the inefficiency of traditional 
segmentation methods, which rely on slow and difficult manual processes. By 
leveraging the immersive environment and intuitive handling of virtual reality, we aim 
to streamline segmentation, making the process faster and more user-friendly. 

 

1.7. What advantage does your protocol offer compared to other techniques? 
Carissa Chestnut: Our protocol leverages virtual reality for segmenting membranes in 
cryo-electron tomograms. The immersive 3D environment allows for faster and more 
accurate segmentation compared to traditional methods. Additionally, it serves as an 
excellent platform for training and education, making it versatile for both research and 
learning applications. 
 

How will your findings advance research in your field? 

1.8. Marcus Velazquez: Virtual reality-based segmentation allows researchers to interact 
with data intuitively, enabling faster and more accurate segmentation. This 
advancement enhances data analysis and accelerates discoveries. Additionally, it 
provides an effective platform for training the next generation of researchers, 
fostering skill development in cryo-ET analysis. 

What new scientific questions have your results paved the way for? 

1.9. Carissa Chestnut: This work will aid in training the next generation of scientists and 
streamline the clean-up of automated segmentation. By reducing the time spent on 
manual tracing, researchers can focus more on analyzing the arrangement of cellular 
structures, leading to deeper insights and a better understanding of biological 
systems. 

What research questions will your laboratory focus on in the future? 
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1.10. Marcus Velazquez: Our lab will focus on using virtual reality software like syglass as a 
complementary approach to segment cryo-ET data to answer several biological 
questions.  

 
 

Videographer: Obtain headshots for all authors available at the filming location. 
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Testimonial Questions (OPTIONAL):  
 

Answers to these questions will not appear in the video but may be featured in our journal's 
promotional materials. 

• Enter the full name of the author who will deliver the statement. 

• Answer in full sentences, in a style suitable for being spoken aloud.  

• Limit the length of each statement to 50 words or fewer. 
 

 

What motivated you to choose JoVE for publishing your research? 

1.11. Carissa Chestnut: JoVE offers a unique platform for sharing protocols to enhance 
reproducibility. Its use of visual aids significantly improves the clarity and accessibility 
of complex methods, making it an ideal choice for communicating our research 
effectively. 

How does the research community benefit from video publications as compared to standard 
text publications? 

1.12. Marcus Velazqueze : Video publications offer greater clarity for protocols that are 
difficult to describe in text. For example, in our work with VR segmentation, the video 
demonstrates the immersive nature of the process, providing researchers with a 
deeper understanding that text alone cannot convey. 

  



DRAFT: DO NOT USE FOR FILMING 
 

© 2024, Journal of Visualized Experiments  Page 8 of 12 

Protocol Videos  

Each video will include a section of your protocol and accompanying results, if applicable. Use 
Track Changes when making edits or revisions. 

• The two-digit steps (e.g., 2.1., 2.2.) are the narration. Professional voiceover artists will 
narrate the video.  

• Red italics are pronunciation guides indicating how the word will be spoken.  

• Filming should take no more than 10 minutes per step. If a step takes more than 10 
minutes, prepare the product for that step in advance. 

Protocol: 

• The three-digit shots (e.g., 2.1.1., 2.2.2.) are the actions that the videographer will capture.  

Representative Results:  

• The three-digit numbers (e.g., 2.3.1., 2.3.2.) are the figures/tables from your manuscript. 
These will not be recorded by the videographer. 

• Please review the result section to make sure it logically follows the video. 

• Please note that the video cannot include voiceover without an accompanying visual. 

 

2. Video 2: Integrating Virtual Reality into Cryo-Electron Tomography Segmentation for 
Enhanced Accuracy 

Demonstrator: Click here to enter name of demonstrator(s) 

Protocol 

2.1. To begin, convert raw Cryo-ET tomograms into a data format compatible with syGlass 
(sai-glass) , such as TIFF (tiff) stacks [1]. 
2.1.1. WIDE: Talent taking a seat the computer station.  Videographer: In addition to 

this video shot, please also take a photograph of talent performing this action. 
Make sure that it is at least a half-body shot with the talent's face visible and 
zoom out so we have room for cropping.  

 
2.2. Set the signal to ensure that the particles are white on black [1]. Perform histogram 

equalization using ImageJ to enhance the image contrast [2]. 
2.2.1. SCREEN: Setting the signal to make the particles white on black.  
2.2.2. SCREEN: ImageJ interface showing the application of histogram equalization to 

the data. 
Authors: Please create screen capture videos of the shots labeled as SCREEN, create a 

screenshot summary, and upload the files to your project page as soon as possible: 

https://review.jove.com/account/file-uploader?src=20693993  

https://review.jove.com/account/file-uploader?src=20693993
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2.3. Launch the virtual reality software on the computer [1]. Navigate to the File menu and 

select Create Project [2]. 
2.3.1. SCREEN: Starting the software from the computer interface. 
2.3.2. SCREEN: Software interface showing selection of the File > Create Project 

menu. 
 

2.4. Click on Create New Project and then on Add Files in the software [1]. Navigate to the 
location of the TIFF files and import them into the project [2]. 
2.4.1. SCREEN: Software interface showing Create New Project > Add Files selection. 
2.4.2. SCREEN: File browser showing the TIFF files being selected for import. 

 
2.5. When prompted, confirm that the files are not part of a time series after clicking No 

[1]. 
2.5.1. SCREEN: Software prompt with the Time Series option and the user clicking 

No. 
 

2.6. Assign a name to the project [1] and click Save to create the project under the project 
list [2]. 
2.6.1. SCREEN: Project naming interface with the user inputting a project name. 
2.6.2. SCREEN: Clicking SAVE for saving the list. 

 
2.7. Double-click on the project to open the tomogram and load it into the interactive 

virtual reality environment [1]. 
2.7.1. SCREEN: Double-clicking the project name and the tomogram loading into the 

VR interface. 
 

2.8. For setting up virtual reality or VR, connect the VR headset and hand controllers to the 
computer [1]. 
2.8.1. Talent connecting the VR headset and hand controllers to the computer. 

 
2.9. Follow the onscreen instructions to calibrate the VR environment [1]. Ensure the field 

of view in the VR environment contains the desired area for segmentation [2]. 
2.9.1. SCREEN: Onscreen calibration instructions and talent completing the steps. 
2.9.2. SCREEN: Cursor hovering over the field of view in the VR environment. 

 
2.10. Then, click on the Visualization button in the software interface [1]. Adjust 

visualization options such as contrast, windowing, brightness, and threshold sliders to 
enhance the signal and minimize noise [2]. 
2.10.1. SCREEN: User selecting Visualization in the software interface. 
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2.10.2. SCREEN: Adjustments to contrast, brightness, and threshold sliders within the 
software. 
 

2.11. Use the hand controllers to pull the tomogram closer or push it away for better 
examination [1]. 
2.11.1. Talent using the hand controllers. 

2.12. Activate the Cut tool using the left-hand controller [1]. Visually inspect different slices 
within the tomogram [2]. 
2.12.1. SCREEN: User activating the Cut tool in the VR software. 
2.12.2. SCREEN: Cursor hovering over the slices of the tomogram. 

 

Segmentation  

2.13. Navigate through the tomogram to the desired slice where segmentation will begin 
[1]. 
2.13.1. SCREEN: Desired slice appearing. 

 
2.14. Activate the Region of Interest (ROI)  (or R-O-I) option under the Annotation menu 

using the hand controllers [1]. A green box will appear in the tomogram [2]. 
2.14.1. SCREEN: Activation of the ROI option under Annotation. 
2.14.2. SCREEN: A green ROI box appearing within the tomogram in the software. 

 
2.15. Adjust the size and position of the green box to the area to be segmented [1]. 

2.15.1. SCREEN: adjusting the size and position of the green box to the area to be 
segmented. 
 

2.16. Now, lock the ROI (R-O-I) using the left-hand controller [1]. The tool will switch to 
paint mode for segmentation [2]. 
2.16.1. Talent performing ROI locking action using the left-hand controller. 
2.16.2. SCREEN: Transition to paint mode for segmentation in the software. 

 
2.17. Zoom in or out of the tomogram for precise segmentation [1]. 

2.17.1. SCREEN: Zooming into the tomogram within the VR environment. 
 

2.18. Adjust the paintbrush size with clockwise or counterclockwise rotations for optimal 
control [1]. 
2.18.1. Talent adjusting the paintbrush size using the hand controller rotation. 

 
2.19. Carefully segment the region of interest, such as mitochondrial membranes, within 

the three-dimensional area [1]. 
2.19.1. SCREEN: Segmentation of mitochondrial membranes being performed. 
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2.20. Engage erase mode using the secondary controller trigger to correct segmentation 
errors [1] and use the same motion as segmentation to erase [2]. 
2.20.1. SCREEN: Talent activating erase mode using the secondary trigger. 
2.20.2. SCREEN: Erasure of segmentation errors in progress. 

 
2.21. Repeat the segmentation process for all regions until the tomogram is fully segmented 

[1]. 
2.21.1. SCREEN: Fully segmented tomogram. 

 
2.22. After completing the segmentation, click on the completed project to highlight it [1]. 

Click on the Projects tab and select ROIs (r-o-iez) to proceed [2]. 
2.22.1. SCREEN: Project being highlighted in the software interface by clicking on it. 
2.22.2. SCREEN: Navigation to the Projects > ROIs section in the software. 

 
2.23. Choose to export the entire volume or a specific region of interest [1] and specify the 

export location for the segmented data [2]. Now, load and analyze the segmented 
data in the preferred software to generate publication-quality figures [3]. 
2.23.1. SCREEN: Export options in the software showing the volume or specific ROI 

selection. 
2.23.2. SCREEN: Specifying file path for saving the segmented data. 
2.23.3. SCREEN: Segmented data being loaded in the secondary software. 

 

Importing Binary Mask into the Software for Cleanup 

2.24. After preparing cryo-ET data, right-click on the project and click Add mask data [1]. 
Then, navigate to where the initial segmentation is saved and import it under the 
same project [2]. Engage ROI annotation to make edits to the initial segmentation [3]. 
Finally, add or erase segmentation to clean up the initial segmentation [4-TXT]. 
2.24.1. SCREEN: Right-clicking on the project and clicking Add mask data. 
2.24.2. SCREEN: Navigating to the initial segmentation and importing it under the 

same project.  
2.24.3. SCREEN: Engaging ROI annotation and making edits to the initial segmentation  
2.24.4. SCREEN: Adding or erasing the segmentation to clean up the initial 

segmentation.  TXT: Picking particles coordinates using the VR software 

 

Representative Results 

2.25. Weighted-back projection of tomograms reconstructed at 16 angstroms per pixel 
revealed mitochondrial and membranous structures following denoising and missing 
wedge correction [1]. 
3.1.1 LAB MEDIA: Figure 1A. Video editor: Focus on the oval structure in the middle of 
RPE1_3 image. 



DRAFT: DO NOT USE FOR FILMING 
 

© 2024, Journal of Visualized Experiments  Page 12 of 12 

 
2.26. Visualization in an immersive virtual reality environment enabled detailed 3D 

inspection of membranes after histogram equalization enhanced the contrast [1]. 
3.2.1 LAB MEDIA: Figure 1B. Video editor: Highlight the round and oval structure in the 
middle of RPE1_2 image. 

2.27. Manual segmentation delineated mitochondrial and organelle structures with high 
accuracy using VR tools, including the precise mapping of membrane boundaries and 
ROIs [1]. 
2.27.1. LAB MEDIA: Figure 1C. Video editor: Highlight the round/oval/other cell 

structures with coloured bordered in the middle of RPE1_2 image. 
 

2.28. Final 3D renderings revealed detailed mitochondrial features such as outer and inner 
membranes, cristae, and calcium phosphate deposits with smoothened meshes [1]. 
3.4.1 LAB MEDIA: Figure 1DVideo editor: Highlight the RPE1_2 image. 
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